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Introduction

This is going to hopefully be a very brief document that can help you save your image files for web
viewing so that you can save server space that you may have been allotted by a particular image
hosting company OR to help you fully utilize the server space that you have through your own web
hosting company (If you have your own domain name etc.).

Any questions or comments about this document should be sent to the.nexus@gmail.com — please
note however that the author of this document is in no way obliged to adjust, tweak, play with or
otherwise juggle this document in any way, shape or form; after all, he’s writing this out of the goodness
of his own heart ©.

Standards Used Within This Document

The standard image manipulation software that is referred to within this document shall be Adobe
Photoshop CS2 however this is by no means the only image manipulation software that is available.
PaintShop Pro, IrfanView, GIMP and a number of others can all be used to accomplish what will be
shown here within this document. Please be aware however that since each of these pieces of software
have their own unique menus that the quoted menu items and locations listed within this document may
or may not conform to programs other than Adobe Photoshop CS2.

You've been duly warned ©

Step 1 Opening The Image File and Manipulating/Editing The Image

Let's begin at, where else, the beginning; first open your digital image file that you've recently scanned
(if you're using film) or downloaded from your camera (if you're using one of them there new fangled
“digital” cameras... sheesh.. kids these days.. © )
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As you can see, we are opening “crop0013.jpg” which happens to be a B&W photo.

Please note: This workflow is strictly for JPEG / JPG files ONLY if you are opening a RAW digital
file the workflow listed below will occur AFTER the RAW conversion. If you need help with RAW
conversion software or information on RAW conversion you've come to the wrong document © Feel
free to Google “RAW conversion” (yes, Google is now a verb.. it's in Webster’s dictionary don’t ya
know!!!)

Once the photo is opened on the desktop of your image manipulation program it will be sized (usually)
accordingly so that it fits reasonably to your screen resolution. You can now go about your business of
editing your photograph; be it to touch it up, crop, or adjust exposure etc. In the case of our
“crop0013.jpg” we are cropping this to an 8x10 image. Please note that the sizing for viewing the image
is 16.7% of the total size (located in the top left of the viewing window — i.e. crop0013 @ 16.7%)
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Step 2 Adjusting The Physical Size Of The Image

After you've completed all of the standard editing that you need to complete for your image, you are
ready to adjust the physical size of the image in order to prepare to save it for the viewing on the web.
In order to adjust the image size, locate the “Image Size” menu item within the “Image” menu. It's about
six menu items down from the top of the “Image” menu.



Remember we are working with Adobe Photoshop CS2 in this document and you may have to locate a
different menu item within your own image manipulation software !!
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Once you click the “Image Size” menu item you will receive a pop-up dialogue which looks like the
following:
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This Image Size dialogue gives the dimensions of the image that is opened as well as the size of the
image and the resolution of the image (usually in pixels per inch or dots per inch). The resolution is the
KEY to ensuring that your images LOOK good online but do not take up a lot of PHYSICAL SPACE

online.

Place your cursor in the “Resolution” box of the Image Size dialogue. Ensure that the resolution reads
72 pixels/inch or 72 dpi. You’ll note, that once you change the resolution the physical width and
height of the image will change. You may also want to check the “Pixel Dimensions” of your image
by looking at the associated fields in the “Image Size” dialogue box. While the pixel dimensions may not
mean much to you (because you may have a 24” wide screen monitor © ) they do mean a lot to a fair
chunk of people who may be browsing your image online.

Check for any rules or regulations that may be in place in the online gallery that you're saving for. If it's
your own website and your own server space then feel free to make that image as large as you want
but remember that people will get frustrated and downright upset about having to scroll horizontally or
vertically to view an image. My general rule of thumb is to make the image no longer than 600 pixels
on any one side. This is palatable for those still viewing the web at a screen resolution of 800x600
(although the amount of people viewing at this resolution is slowly dwindling).

Once you have completed your changes, click the “OK” button to apply this change to your image.
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After you've clicked the “OK” button your image may look a bit “odd” on your desktop.
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Awww... look how cute it is.. all small and in the middle of the big grey background like a little postage
stamp. Don't forget; seeing as we’ve not changed anything else in the image, the viewing is still being
done at 16.7% of the original size and therefore you need to “zoom in” on the image to make it 100%
on your screen. You can do this any number of ways but most image manipulation software has a
“magnifying glass” tool that does this for you. Use the magnifying glass to zoom in to 100%
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Ahh.. that’s better.. now we can move onto . . .

Step 3 — Saving For Web Viewing

Now there are two ways to go about this step if you use Adobe Photoshop CS2 — there’s a long way
and a short way. The “long way” is the way that we’ll cover first as it is also the way that hopefully most
other image manipulation software will be compatible with.

The “Long Way”

Now that we're all ready to save for the web; simply click on your “File” menu and then click on the
“Save As” menu item.
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| try to save my documents in a “web” folder within the original folder from where the “non web sized”
versions are housed. It's just easier for me that way © You can name the file name whatever you feel
is appropriate. Click “Save” once you're ready to save the image. All that other stuff you see in this
dialogue box such as “ICC Profile” and such is not covered here. Like | said before, if you want further
information on that sort of stuff; feel free to Google it ©

Once you click “Save” you'll be presented with yet another dialogue box that looks like the following:
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Here is where you realize your savings when it comes to your image file. You'll note that there is a
“Quality” figure when you first look at the dialogue. This figure can range anywhere from 1 to 12. The
values correspond to how high in quality you want your image to appear. Choosing “12” creates a
LARGE file size (even though you've already reduced your resolution as we did in Step 2) while
choosing “1” creates a small file size (but of course, the quality of the image suffers). Choose a value
of “5” or “6” and you'll get the best of both worlds — a nice reasonable file size; in our case,
approximately 52 KB, and a good looking image.

You can also make the image smaller in terms of size by choosing the “Progressive” radio button in the
“Format Options” portion of this dialogue box. You can then choose 3, 4 or 5 as the number of scans to
use on the image. This does not affect image quality but can impact the physical size of the file.

You'll note that Photoshop CS2 also gives you a little slice of how long the image may take to download
depending on one’s connection speed — here it appears to take about 9 seconds to download the
image at 56.6Kbps.

Once you're satisfied with the file size and file quality, click “OK” and this completes optimizing your
image file for web viewing!!

The “Short Way”

Now, that was the “long way” of doing things. If you take a look at the file details of the image you just
saved, and compare it to the original, you'll note that it's GREATLY reduced in physical size; likely from
a few Megabytes down to under one hundred kilobytes which makes any web server (and web
SURFERS) very happy ©.



The “short way” of saving for the web only applies to Adobe Photoshop CS2 users (and CS as well if
I’'m correct). This method is the preferred method of saving for web since it's better to perform all your
image manipulation before converting to RGB8 (even if your image is in Grayscale); and the short way
does this automatically for you. What's the reason for choosing this method? Well, JPEG compression
works far better in RGB8 than it does in RGB16 or Gray16 (if you had scanned images in this format).
This method, for those using RAW files, also does not put any EXIF image information into the image.
This allows further space savings on web servers.

Again, once we're ready to save the file after all the happy-go-lucky image editing we've done we can
go to the “File” menu and click on the “Save For Web” menu item as shown here:
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Once you click on “Save for Web” the following dialogue box will appear. Don’t be alarmed, it can be
daunting, but it's just combining a bunch of stuff from “The Long Way” into one neat little dialogue box:
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You'll note that the image appears in the middle of the dialogue, a number of tabs on the upper left as
well as some familiar Adobe Photoshop tools, and various buttons and drop down menus/fields on the
upper right.

Let’s take a closer look at the upper right menus and fields:
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You'll note that many of the items here are similar to the dialogue boxes from “The Long Way”. The
“Quality” field moves from 1 to 100 (representing a percentage) instead of from 1 to 12. “Blur” can be



added to a photo as well as other items such as “Matte” etc. We're most concerned with the “Quality”
field.

You’'ll note that if you adjust the “Quality” field to 100 you'll see the word “Maximum” appear in the field
to the left. In the case of our image, we have the “Quality” field set to 50% and the field just to the left
shows as “Medium” - again, this is a combination of image quality and size that gives us the most
adequate image for web viewing.

With the “Quality” field set to 50, we can click the “Save” button. This brings up a dialogue box that
looks like what we saw in “The Long Way” only it’s just a wee bit different:

Save Optimized As 7=

Seremin | 3 meh “ ¥ B
) IE_':":‘I‘.‘][':"-BI:I
‘3 E.-l:lunlllllllﬁ-nq
Wy Fiscert g_-:'u:ll][lli--u;l
Cacursnc: 13 cropll 0. g
— B eropllr32_ g
€
Daskiop
g
—
Py Dt ks
9
Hy Corpuia
i 3
iy Mibwark
Plap=s
Fil s pame TR b | F
Semm s e Imagas Orp [~ gl w |_E£DE' |
Setfinge .I:Ic{-ml‘S‘-:lim:. w
Slcie:

Instead of having all these other options like “ICC Profile” and such, this is a simple “Save Optimized
As” dialogue. Again, simply name the file as you see fit and click the “Save” button once you have
decided where on your system you wish to save your file.

Either with “The Long Way” or “The Short Way”; please remember where you are saving your web files
so that you can locate them when you need to upload them to your web host, image host, or web

gallery.

Conclusion

So that does it.... For now.... ©

Please do not hesitate to send your slings and kudos to my email address located at the beginning of
this document and hopefully we can make this something that we can refer to in the future for all
“newbies” in all areas of photography!! ©



